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1. Introduction 
In this studio, you will continue to use the Oracle database system.  In particular you will 
investigate the use of embedded SQL with Oracle.  The name of the embedded SQL interface for 
Oracle is Pro*C.  The programming language that you will use is the C programming language 
(it is also possible to use C++ with Pro*C).  Don't worry if you do not know C well.  You will be 
given most of the program and all that you need to do is add the required embedded SQL 
statements.  Familiarity with Microsoft Visual C/C++ is a help, but again not a requirement. 

This studio will also use The Movies Database (the full database).  In fact, we will return to the 
game Six Degrees of Kevin Bacon.  The program that you complete in this studio finds and 
displays the titles of all movies in which two given actors played roles.  Such a program might be 
useful to you as you play the Kevin Bacon game and try to construct longer paths from Kevin 
Bacon to other actors.  For example, when given the names Woody Allen and Diane Keaton, the 
program produces the following output: 

Joi nt  Fi l ms f or  Woody Al l en and Di ane Keat on 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  
Pl ay i t  Agai n,  Sam 
Sl eeper  
Love and Deat h 
Anni e Hal l  
Manhat t an 
Manhat t an Mur der  Myst er y  

 
2. Getting Star ted 
The ".pc" file extension is used for Pro*C files, that is, files with embedded SQL in a C program.  
A file Pr ogr am. pc  contains a C program for computing the names of films in which two given 
actors played roles.  The only thing missing from the file is the required embedded SQL.  In 
place of each SQL statement is a block of comments describing what the embedded SQL should 
do.  Your job is to replace these comment blocks with the required embedded SQL statements. 
You must then get the resulting program to run. 

The C compiler that we will use with Pro*C for this studio is Microsoft Visual C/C++.  
Everything has been set up for you in a workspace that you must copy to your computer.  To do 
this, use a web browser to download the file  

ht t p: / / www. cs. r pi . edu/ ~si bel / dbs/ st udi os/ 5/ St udi o5. Zi p 

to your computer.  When you download this file, be sure that it is placed on the C: drive as file 
C:\Studio5.Zip.  Placing it anywhere else will lead to error messages from the compiler when 
you try to compile it later.   



 

The file is a zip file, which is a compressed file containing a folder with many things in it.  You 
must unzip (decompress) the file before you can use it.  To do this, double click on the file icon 
for the file.  Depending on what tool is installed on your computer for unzipping files, either the 
file will automatically unzip itself or the zip utility window will appear.  If the zip utility window 
appears, you will see near the top of it a button labeled Extract.  Click on this Extract button.  In 
the resulting window, click on the line for the C: drive.  When you do this a button appears in the 
lower right corner of the window labeled New Folder.  Click on this New Folder button and type 
Studio5 in the text entry box that appears.  Then click on the OK button.  This says that you want 
to uncompress the zip file in a new folder named Studio5 on the C: disk.  Finally, click the 
Extract button in the upper right corner of the window to uncompress the files into this new 
folder.  As mentioned above, some unzip tools will do all this work automatically when you 
double click on the icon for the Studio5.Zip file. 

Now look for the Microsoft Visual C++6 icon on the Desktop and double click on it to start 
Microsoft Visual C++.  Once it starts, click on the File menu at the top of the window and then 
on the Open Workspace entry in the menu that pops down.  In the dialogue box that appears 
search for the file ESQLProj.dsw in the C:\Studio5 folder that you just created.  This is the 
Microsoft Visual C++ workspace that contains everything that you need for this studio.  Open 
this workspace file. 
 

3. Configur ing Visual C++ 

Before going any further, it is necessary to configure Visual C++ so that it can find the Pro*C 
precompiler and the required include and link libraries.  To do this, first look in the file system 
on your computer to determine where the orant directory is.  If you are using one of the PCs in 
VCC North or Pitts 4114, you will probably find this directory at either C:\Apps\orant or at 
C:\Apps1\orant.  If you are using your own computer, then it will be where you installed Oracle. 
Remember the path name to the orant directory. 

Now return to the Visual C++ window.  On the left side of this window is a listing of the files in 
the ESQLProj.dsw project that you have opened.  One of the Source files in the list is 
PROGRAM.PC.  Click once on this file name to highlight it.  Now click on the Project menu at 
the top of the Visual C++ window and select the Settings menu item in the menu that pops down. 
The Project Settings window appears on the screen.  Click on the Custom Build tab on the right 
side of this window and look at the text in the textbox labeled Commands.  This text is a file 
name that has Orant in the middle.  Make sure that the beginning of this file name is the correct 
path name to the orant folder.  If the path name is incorrect, edit it to correct it.  Then click on the 
OK button at the bottom of the Project Settings window. 

Back in the Visual C++ window, click once on the file name SQLLIB80.LIB on the left side of 
the window to highlight this file name.  Now click on the View menu at the top of the Visual 
C++ window and then on the Properties menu item that appears in the menu that pops down.  
The Source File Properties window appears.  Click on the General tab and look at the path name 
in the textbox labeled “File name:” .  If the path to the orant directory is incorrect, correct it in the 
lower textbox labeled “Persist as:” .  Then click on the close button for the window (the square 
with an x in it in the upper right corner of the window). 

Now click on the Tools menu at the top of the Visual C++ window, and then on the Options 
menu item.  In the Options window that pops up, click on the Directories tab.  In the box labeled 
"Show directories for" select "Include files".  You should see a gray box at the end of the list of 



 

Directories.  Click inside this gray box twice to activate it.  In the box type 

C: \ Apps1\ Or ant \ Pr o80\ C\ I ncl ude 

changing the path name to the orant folder as necessary.  Then click on the OK button.  At this 
point Visual C++ should be configured correctly to use the Pro*C precompiler. 

 

4. Looking at the Program in the File movie.pc 

Begin by studying the Pr ogr am. pc  program listed at the end of this document and displayed in 
the Visual C/C++ window.  Execution of the program begins in the main function by prompting 
the user for the names of two actors.  It then converts these actor names into actor IDs using two 
queries to the Actors relation in The Movies Database.  It then creates a cursor for a query over 
the Casts and Films relations to get the titles of all films in which the two actors both played 
roles.  As each such film title is retrieved using the cursor, the title is displayed on the screen. 

All the C code required to implement the program is already present in the file Pr ogr am. pc . To 
finish the program you must add the necessary embedded SQL.  The places where this must be 
done are indicated by block comments.  The next section provides the details that you will need 
to know to insert the required embedded SQL statements. 
 

5. Completing the movie.pc Program 
The comment blocks in the Pr ogr am. pc  program where code must be inserted are numbered. 
These numbers are used in the discussions below to refer to each comment block.  The window 
displaying the program in Microsoft Visual C/C++ is a WYSIWYG editor window.  You can use 
it to make the required additions to the program text using standard word processing techniques. 

Comment Block #1 

The first addition that you must make to the Pr ogr am. pc  program is to include the SQL 
communications area so that the program can communicate status information with Oracle.  The 
name of the file that defines the SQL communications area is sql ca. h.  The easiest way to 
include it in your program is to use an EXEC SQL INCLUDE statement.  Thus, you need to add 
the line: EXEC SQL I NCLUDE "sql ca. h";  to the program. 

Comment Block #2 

Here you need to add the declarations for program variables that will be used in SQL queries.  
You must declare the following variables: 

 Var iable Name Var iable Type   Initial Value (if any) 
 stagename1  varchar length 50  none 
 stagename2  varchar length50  none 
 filmname  varchar length 100  none 
 actorid1  int    none 
 actorid2  int    none 
 username  char length 10    your Oracle userid in " " 
 password  char length 15   your Oracle password in " " 
 db_string  char length 10   "ora8" 

The general syntax to declare SQL variables is the following: 
 EXEC SQL BEGI N DECLARE SECTI ON;  
  t ype var i abl e;   / *  f or  i nt  var i abl es * /  



 

  t ype var i abl e[ l engt h] ;  / *  f or  var char  and char  * /  
  t ype  var i abl e[ l engt h]  = val ue;  / *  f or  i ni t i al  val ues * /  
  .  .  .  
 EXEC SQL END DECLARE SECTI ON;  

Add the necessary lines to declare the required SQL variables as described above.  Remember 
that in C, when declaring an array to represent a string, the size of the array is specified in square 
brackets following the name of the variable as shown in the examples above. 

Comment Block #3 

You need to set up error handling so that if Oracle fails or if a query doesn't find any tuples that 
satisfy a query the program displays an appropriate message.  This might occur, for example, if 
the user enters the name of an actor that is not in The Movies Database.  

In the case of an Oracle error, you want to call the sqlerror() function that is defined at the end of 
the Program.pc file.  This function consults the SQL communication area (sqlca) for a message 
about what is wrong.  To do this, add the following line to the program: 

 EXEC SQL WHENEVER SQLERROR DO sql er r or ( ) ;  

In the case where a query doesn't find any tuples, you need to print an appropriate message.  To 
do this, add the following line to the program: 

 EXEC SQL WHENEVER NOT FOUND DO pr i nt f ( " Not  f ound. \ n" ) ;  

Comment Block #4 

At this point, you want to connect to the Oracle database so that you can start to query it.  Since 
it is possible that you might want to use more than one database, each database has to have a 
name.  In this program, we will use only one database, but we still need to name it.  We will 
name it DB_NAME using the following statement that you must add to the program: 

 EXEC SQL DECLARE DB_NAME DATABASE; 

Now you must connect to the database that we want to call DB_NAME.  Do this with the 
following command that you must add to the program: 

 EXEC SQL CONNECT :username IDENTIFIED BY :password 

  AT DB_NAME USING :db_string; 

Note that this command uses the program variables username, password, and db_string defined 
earlier. 

Comment Block #5 

Here you must insert two SELECT-INTO-FROM-WHERE statements that use The Movies 
Database to convert the two actor's names entered by the user (in variables st agename1 and 

st agename2) to actor IDs that are put into variables act or i d1 and act or i d2.  The general form 
for this statement is the following: 
 SELECT <at t r i but e l i s t > 
 I NTO <var i abl e l i s t > 
 FROM <r el at i on l i s t > 
 WHERE <condi t i on>;  

Remember that when a program variable is used in a SELECT statement, a colon must precede 
its name.  Insert the required two SELECT statements into the program.  Remember that you 
must append the prefix "movi es. " to the names of relations in The Movies Database. 



 

Since you want to use database DB_NAME to process this query, precede your query with: 

EXEC SQL AT DB_NAME  

rather than just EXEC SQL like you have done before. 

Comment Block #6 

The query for comment block #6 computes the titles of all films in which both actors appeared. 
There may be more than one film title identified by this query.  Hence, because of the multiple 
results, you must use a cursor for this query to retrieve the results one by one.   

Here you must create the cursor and define the query for it.  This query takes the actor IDs of the 
two actors (in variables act or i d1 and act or i d2) and finds the titles of all movies in which they 
both appeared.  The format of the SQL statement to create a cursor and define its query is the 
following: 

 EXEC SQL AT DB_NAME DECLARE <cur sor  name> CURSOR FOR 
 SELECT <at t r i but e l i s t > 
 FROM <r el at i on l i s t > 
 WHERE <condi t i on>;  

Design the required query and use it to declare a cursor named f i l mcur sor  in the program.  
Note again that you must use AT DB_NAME to specify the database to use for processing the 
query. 

Comment Block #7 

Once the cursor is defined, you need to open it.  The general format of the SQL statement that 
opens a cursor is the following: 

 EXEC SQL OPEN <cur sor  name>;  

Insert the SQL statement to open cursor f i l mcur sor .  Also remember to add AT DB_NAME to the 
statement to specify which database to use. 

Comment Block #8 

The program is about to enter a loop that will fetch film titles in the query result using the cursor.  
However, before entering the loop, you must create a way to terminate the loop when all film 
titles have been retrieved.  The general form of the SQL statement to do this is the following: 

 EXEC SQL WHENEVER NOT FOUND DO <C st at ement >;  

In this case, you want to break out of the loop that the program will be executing.  Hence, the C 
statement that you want to execute is the br eak  statement, which consists of the single word 
br eak . 

Insert the necessary SQL statement to terminate the loop when all results have been fetched from 
the cursor.  In this case you don't need to add AT DB_NAME since this statement is done locally in 
the program. 

Comment Block #9 

Inside the loop the program fetches the next film title in the query result.  This is done using the 
FETCH SQL statement.  The general format for this statement is the following: 

 EXEC SQL FETCH <cur sor  name> I NTO <var i abl e l i s t >;  

In this case, the cursor name is f i l mcur sor  and the query for cursor f i l mcur sor  has only one 



 

attribute in its SELECT.  Hence, there should be only one variable in the variable list of the 
FETCH statement.  This variable is program variable f i l mname.  Write the required FETCH 
statement to fetch the film title from the query result.  Remember that program variables must be 
preceded by a colon and that AT DB_NAME must be added since this fetch statement must be 
processed by a specific database. 

Comment Block #10 

At this point, the loop has terminated and all film titles have been displayed.  You must now 
close the cursor.  The format of the statement required to do this is: 
 EXEC SQL CLOSE <cur sor  name>;  

Insert this statement into the program.  Since the cursor is associated with a specific database, 
you must include AT DB_NAME in this statement. 

Comment Block #11 

Before terminating the program you should commit the transaction so that others can use the 
database.  The format of the statement required to do this is: 

 EXEC SQL COMMI T WORK RELEASE;  

While you are searching the database, you do not want other users to be making changes to it.  
By committing the transaction, you are telling Oracle that your search is done and that it is now 
safe for others to make changes to the database. 

Insert this statement into the program and include AT DB_NAME since again the transaction you 
are committing is for a specific database. 

At this point, the program is complete and you are ready to try compiling and running it. 
 

6. Compiling and Running the Program 
Now you are ready to compile and run the program.  To make this as simple as possible, the 
Visual C/C++ workspace has been set up to do everything necessary to run the Pro*C 
preprocessor and then compile and link the program so that it is ready to run. 

To preprocess, compile and link your program click on the Build button in the toolbar at the top 
of the Visual C/C++ window (see the picture below). 

 

Any messages, including error messages, will appear in the windowpane at the bottom of the 
Visual C/C++ window.  You can ignore most warning messages, but error messages must be 
fixed.  If  the final message in this window says that there are 0 errors, then you are ready to run 
the program and can skip the next few paragraphs.  If there are error messages, then you will 
need to fix the program and try building it again. 

If there are errors, scroll to the top of the message windowpane and find the first error message.  
Try to figure out what is wrong. Before you try to fix the error, notice which window you are 
editing.  You can see this in the blue title bar at the top of the Visual C/C++ window.  If the title 
bar has Program.pc in it, then go ahead and fix the problem.  If the title bar has Program.c in it, 
then you must switch to file Program.pc before you fix the problem.  To do this, look in the 

Build Button Execute Button 



 

windowpane to the left of the editor window.  You should see Program.pc listed.  Double click 
on it and the editor window will change to file Program.pc.  Now you can go ahead and fix the 
error. 

What is the file Program.c that might appear in the editor window?  It is the output of the Pro*C 
preprocessor.  It has all the SQL statements removed and replaced by function calls and other 
stuff.  Making changes to this file will not correct the errors because this file is deleted and 
recreated the next time that you build the program.  So be careful to make all your program fixes 
in the Program.pc file and not the Program.c file. 

After you have fixed a few of the errors, you might want to Build the program again.  Visual 
C/C++ tends to generate several error messages for the same mistake.  One fix may get rid of 
several messages.  The error messages are not always useful in identifying the problem.  
However, they do tell you where the problem is.  Do your best to figure out what is wrong.  If 
you get rid of the errors one by one, eventually the program will build error free. 

To run the program once all the errors are fixed, click on the Execute button (it looks like an 
exclamation point, see the picture above).  The program will run and prompt you for the names 
of two actors.   You might try any of the following three pairs: 

  Humphrey Bogart  William Shatner  Woody Allen 
  Lauren Bacall   Leonard Nimoy  Diane Keaton 

Each pair has appeared in several movies together.  If the program doesn't run correctly, try to 
figure out what is wrong, fix it, and build and run it again, until you get it working correctly. 
 

7. Things to Think About 
This studio has only scratched the surface of what you can do with Embedded SQL using 
Oracle's Pro*C.  For example, it is likely that much of the Student Information System is written 
using Pro*C.  If you are interested, you might try modifying your program to do other things 
with The Movies Database. 

If you are interested in exploring the game Degrees of Kevin Bacon in more detail, you might 
find the following web site of interest: http://www.cs.virginia.edu/~bct7m/bacon.html .  For a 
web-based movies database see the following web site: http://us.imdb.com/ . 

In the next studio you will learn how to use the Oracle forms package to build a graphical 
application interface much like you did with Microsoft Access.   
 
 

9. File Program.pc 
/ * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
/ *                                                                   * /  
/ *  Modi f y  t hi s  pr ogr am by addi ng t he necessar y code as i nst r uct ed   * /  
/ *  at  each comment  bl ock st ar t i ng wi t h:                              * /  
/ *                                                                   * /  
/ *        * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * *                * /  
/ *                                                                   * /  
/ *  and endi ng wi t h:                                                  * /  
/ *                                                                   * /  
/ *        * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * *                * /  
/ * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  



 

 
/ *  I nc l ude header  f i l es * /  
#i ncl ude <st di o. h> 
#i ncl ude <st r i ng. h> 
 
/ /  pr ot ot ype f or  er r or  f unct i ons 
voi d sql er r or ( ) ;  
voi d exi t ( i nt ) ;  
 
/ * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * /  
/ * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
/ *  1.                                         * /  
/ *  I nc l ude t he SQL communi cat i on Ar ea.        * /  
/ *                                            * /  
/ * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
/ * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * /  
 
 
i nt  mai n( )  
{  
 char  name1[ 25] ;  
 char  name2[ 25] ;  
 
 / * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  2.                                                    * /  
 / *  Decl ar e var i abl es f or  use i n SQL quer i es             * /  
 / *    s t ageName1  var char  l engt h 50                      * /  
 / *    s t ageName2  var char  l engt h 50                      * /  
 / *    f i l mName    var char  l engt h 100                     * /  
 / *    act or i d1    i nt                                     * /  
 / *    act or i d2    i nt                                     * /  
 / *  Decl ar e var i abl es t o connect  t o dat abase             * /  
 / *    user name    char  l engt h 10,  i ni t  t o Or acl e user i d  * /  
 / *    passwor d    char  l engt h 15,  i ni t  t o Or acl e passwor d* /  
 / *    db_st r i ng   char  l engt h 20,  i ni t  t o " or a8"          * /  
 / *                                                       * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 
 / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  3.                                                       * /  
 / *  Set up er r or  handl i ng f or  cases when Or acl e              * /   
 / *  or  a quer y f ai l s .                                         * /   
 / *                                                          * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 
 / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  4.                                                       * /  
 / *  Connect  t o t he Or acl e dat abase usi ng name DB_NAME       * /   
 / *                                                          * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * /  



 

 
 
 / *  get  act or s st agenames * /  
 pr i nt f ( " Ent er  t he name of  f i r s t  act or :  " ) ;  
 get s( name1) ;  
 s t r cpy( st agename1. ar r ,  name1) ;  
 s t agename1. l en = st r l en( st agename1. ar r ) ;  
 
 pr i nt f ( " Ent er  t he name of  second act or :  " ) ;  
 get s( name2) ;  
 s t r cpy( st agename2. ar r ,  name2) ;  
 s t agename2. l en = st r l en( st agename2. ar r ) ;  
 
 / * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *    5.                                          * /  
 / *    Embedded SELECT st at ement s t o get  t he      * /  
 / *    act or  I Ds f or  t he gi ven act or ' s             * /  
 / *                                               * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  6.                                                           * /  
 / *  Embedded SELECT t o cr eat e a cur sor  named ' f i l mcur sor '   t hat  * /  
 / *  sel ect s t he l i s t  of  degr ee 0 act or s f or  t he act or  whose I D  * /  
 / *  i s  i n var i abl e ' act or I d' .                                    * /  
 / *                                                              * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  7.                                                           * /  
 / *  Embedded SQL t o open cur sor  ' f i l mcur sor ' .                    * /  
 / *                                                              * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  8.                                                           * /  
 / *  Embedded SQL t o br eak f r om t he l oop bel ow when t her e ar e    * /  
 / *  no mor e t upl es t o f et ch f or  cur sor  ' f i l mcur sor ' .             * /  
 / *                                                              * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
  
 / *  l oop t o f et ch t upl es f r om t he dat abase * /  

pr i nt f ( " \ n\ nJoi nt  Fi l ms f or  %s and %s\ n" ,  s t agename1. ar r ,  
       s t agename2. ar r ) ;  

 pr i nt f ( " - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - \ n" ) ;  
 f or  ( ; ; )  {  
 
  / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
  / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
  / *  9.                                                           * /  
  / *  Embedded SQL t o f et ch t he next  t upl e f or  cur sor              * /  



 

  / *  ' f i l mcur sor '  i nt o var i abl e ' f i l mname' .                       * /  
  / *                                                              * /  
  / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
  / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
  / *  put  nul l  t er mi nat or  at  end of  f i l mname * /  
  f i l mname. ar r [ f i l mname. l en]  = ' \ 0' ;  
 
  / *  pr i nt  f i l m name * /  
  pr i nt f ( " %s\ n" ,  f i l mname. ar r ) ;  
 }  
 
      / * * * * * * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
      / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
      / *  10.                                                          * /  
      / *  Embedded SQL t o c l ose cur sor  ' f i l mcur sor '                    * /  
      / *                                                              * /  
      / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
      / * * * * * * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 / * * * * * * * * * * * * * * * * * * * * * *  Begi n * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / *  11.                                                   * /  
 / *  Commi t  t he t r ansact i on and di sconnect  f r om t he dbms.  * /  
 / *                                                       * /  
 / * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * /  
 / * * * * * * * * * * * * * * * * * * * * * * *  End * * * * * * * * * * * * * * * * * * * * * * * * * * * * /  
 
 pr i nt f ( " \ n\ n" ) ;  
 r et ur n ( 0) ;  
}   
 
voi d sql er r or ( )  
{  
 pr i nt f ( " \ n\ nOr acl e Er r or . . . \ n" ) ;  
 pr i nt f ( " %. * s\ n" ,  sql ca. sql er r m. sql er r ml ,  sql ca. sql er r m. sql er r mc) ;  
 ex i t ( 1) ;  
}  
 


